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BAB 10 

 

 

 

 

 

OBJEKTIF 

 

Menggunakan Extension Spatial Analyst untuk : 

 

• Menghasilkan SLOPE menggunakan data DEM 

• Menukar Data Vektor kepada Raster 

• Mengelaskan semula Data Raster menggunakan Kotak Dialog Reclassify 

• Menggabungkan Layer Raster dengan menggunakan ModelBuilder ataupun 

Raster Calculator 

 

 

  

 

 

MMEEMMBBIINNAA  MMOODDEELL  
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LATIHAN 10 : MEMBINA MODEL 

 

Di dalam latihan ini,anda diminta untuk mencari kawasan yang berisiko tinggi berlakunya 

hakisan. Data-data yang akan dibekalkan kepada anda adalah DEM.img (Data Elevation 

Model), Guna Tanah (luse_kuantanClip), Jenis Tanah (soil_kuantanClip) dan Score 

Modelling.xls. 

 

LANGKAH 1: LANCARKAN PROGRAM ARCMAP DAN BUKA FAIL MXD 

 

Sekarang anda akan mulakan dengan melancarkan program ArcMap dan membuka fail 

MXD yang telah disediakan. 

 

� Sekiranya anda mempunyai shortcut ArcMap di paparan desktop, klik dua kali 

ikon tersebut untuk memulakan ArcMap. Sekiranya tiada, klik Start > Programs > 

ArcGIS > ArcMap. 

� Sekiranya anda melihat dialog permulaan ArcMap, pastikan anda klik ‘A new 

empty map’ dan klik OK. 

� Klik ikon   dan pilih Modelling.mxd yang berada di dalam folder 

E:\SpatialAnalyst\Model 

� Di dalam MXD ini hanya terdapat data raster DEM.img, dan anda akan 

menggunakan data raster ini untuk menghasilkan SLOPE dengan menggunakan 

fungsi yang terdapat di dalam Extension Spatial Analyst. 
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LANGKAH 2: MEMASUKKAN TOOLBAR SPATIAL ANALYST KE DALAM ARCMAP 

 

� Di dalam ArcMap, klik menu utama View > Toolbars > Spatial Analyst 

 

� Toolbar Spatial Analyst akan dipaparkan. 
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LANGKAH 3: MENGHASILKAN SLOPE DENGAN MENGGUNAKAN DEM DENGAN 

MENGGUNAKAN SPATIAL ANALYST 

 

Proses seterusnya yang anda akan lakukan adalah menghasilkan SLOPE dengan 

menggunakan DEM. 

 

� Klik pada  Spatial Analyst > Surface Analysis > Slope  

’ 

Kekotak dialog Slope akan dipaparkan. 
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� Pilih Input surface: dem.img 

� Pilih Output measurement: yang anda inginkan Degree ataupun Percent 

� Pada bahagian Z factor, Output cell size: biarkan default. 

� Pada bahagian Output raster:, klik butang Browse , pilih lokasi dimana anda 

ingin menyimpan data tersebut. dan namakannya Slope. 

� Klik butang OK 

� SLOPE yang dihasilkan kelihatan seperti gambar di bawah 

 

� Setelah SLOPE yang diinginkan dihasilkan, kini anda akan mengelaskan semula 

SLOPE tersebut hanya kepada enam kelas sahaja. 

 

LANGKAH 3: MENGURANGKAN KELAS SLOPE DAN MENGELASKANNYA 

SEMULA 

 

� Di dalam ArcMap klik butang kanan Spatial Analyst > Reclassify. 

� Kotak dialog Reclassify akan dipaparkan 
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� Di dalam kotak dialog Reclassify ini, klik butang Classify. 

� Kotak dialog Classification akan dipaparkan. 
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� Pada bahagian Classes: klik anak panah yang terdapat disebelah nombor 9, dan 

pilih nombor 6 daripada senarai yang disediakan. 

 

Ini bertujuan untuk menjadikan data SLOPE anda yang dipecahkan kepada 9 kelas 

menjadi hanya 6 kelas sahaja.Setelah anda mengurangkan kelas pecahan bagi data 

SLOPE anda, ianya akan kelihatan seperti gambar di bawah. 

 

 

 

Setelah kelas SLOPE tersebut dikurangkan kepada 6 kelas sahaja, kini anda akan 

mengelaskan semula nilai-nilai yang terdapat pada SLOPE tersebut. 
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� Pada bahagian Break Values, klik pada nilai yang pertama dan taip 5. 

 

 

� Masukkan nilai-nilai yang berikutnya mengikut urutan, nilai yang kedua 10, ketiga 

15, keempat 20 dan nilai yang kelima 25. 

� Setelah kesemua nilai-nilai tersebut dimasukkan, ianya akan kelihatan seperti 

gambar di bawah. 

 

 

 

� Klik butang OK pada dialog Classification setelah selesai. 
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� Pada bahagian Output raster: di dalam dialog Reclassify, klik butang Browse 

, pilih lokasi dimana anda ingin menyimpan data tersebut. dan namakannya 

SlopeRecc 

� Klik butang OK pada dialog Reclassify. 

 

Keputusan bagi proses Reclassify tadi akan kelihatan seperti gambar di bawah, dimana 

nilai-nilai yang diubah tadi telah dipecahkan kepada SCORE.Jumlah markah 1 adalah 

kawasan yang paling landai dan 6 adalah yang paling curam. 

 

 

 

Anda boleh menukar warna-warna yang terdapat pada data slope yang telah dikelaskan 

semula agar mudah untuk anda membezakan diantara kelas-kelasnya. 
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LANGKAH 4: MENUKAR WARNA KELAS SLOPE 

 

� Klik butang kanan tetikus pada data slope yang telah dikelaskan semula 

(Reclass of Slope of dem.img) dan pilih Properties. 

� Klik  butang tab Symbology sekiranya perlu. 

� Pada bahagian Color Sceme, klik butang kanan tetikus pada senarai warna yang 

terdapat di dalamnya dan uncheck Graphic View. 

 

� Setelah anda uncheck Graphic View, ianya akan bertukar menjadi senarai nama-

nama warna seperti gambar di bawah 

 

�  Daripada senarai tersebut, tekan huruf S pada papan kekunci sehingga anda 

menjumpai Slope. 

� Setelah Slope dipilih daripada senarai tersebut, klik butang OK. 
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LANGKAH 5: MENUKAR DATA VEKTOR KEPADA RASTER 

 

Proses seterusnya yang akan anda lakukan adalah menukar data vektor kepada raster 

dan mengelaskannya semula. Data yang terlibat adalah data Guna Tanah 

(luse_kuantanClip) dan data Jenis Tanah (soil_KuantanClip). 

 

� Klik butang Add Data , dan pergi ke lokasi yang menyimpan layer 

luse_kuantanClip dan soil_KuantanClip. 

� Tekan butang Ctrl pada papan kekunci dan pilih luse_kuantanClip dan 

soil_KuantanClip. 

� Klik butang Add. 

� Di dalam ArcMap, klik Spatial Analyst > Convert > Features to Raster 
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� Kotak dialog Features to Raster akan dipaparkan 

 

� Pada bahagian Input features:, pilih luse_kuantanClip. 

� Pada bahagian Field:, pilih KATEGORI. 

� Pada bahagian Output cell size:, biarkan default. 

� Pada bahagian Output raster:, klik butang Browse  , pilih lokasi dimana anda 

ingin menyimpan data tersebut. dan namakannya Landuse 

� Klik butang OK. 

 

Setelah anda menukar data luse_kuantanClip kepada raster dengan menggunakan 

field KATEGORI, kini anda akan melakukan proses yang sama bagi data 

soil_kuantanClip, dengan menggunakan field CLASS. 

 

� Di dalam ArcMap, klik Spatial Analyst > Convert > Features to Raster. 

� Kotak dialog Features to Raster akan dipaparkan. 

 

� Pada bahagian Input features:, pilih soil_KuantanClip. 

� Pada bahagian Field:, pilih CLASS. 

� Pada bahagian Output cell size:, biarkan default 
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� Pada bahagian Output raster:, klik butang Browse  , pilih lokasi dimana anda 

ingin menyimpan data tersebut dan namakannya Soil  

� Klik butang OK. 

 

LANGKAH 6: MENGELASKAN SEMULA LUSE_KUANTANCLIP DAN 

SOIL_KUANTANCLIP 

 

Setelah kedua-dua data tersebut luse_kuantanClip dan soil_kuantanClip telah anda 

tukarkan kepada raster, kini proses seterusnya adalah anda akan mengelaskannya 

semula mengikut fail excel Score Modelling.xls yang telah disediakan. 

 

� Di dalam ArcMap, klik Spatial Analyst > Reclassify. 

� Kotak dialog Reclassify akan dipaparkan. 

 

� Pada bahagian Input raster:, pilih Landuse 

� Pada bahagian Reclass field:, pilih KATEGORI. 

� Pada bahagian Set values to reclassify, tukar nilai yang terdapat di dalam 

bahagian New values seperti yang terdapat di dalam Score Modelling.xls. 
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� Nilai yang tidak terdapat di dalam Score Modelling.xls, anda boleh buang dengan 

mengklik pada nilai tersebut kemudian klik butang Delete Entries seperti gambar 

di bawah. 

 

� Setelah anda selesai memasukkan kesemua nilai dan membuang nilai yang 

tidak tidak terdapat di dalam Score Modelling.xls ianya akan kelihatan seperti 

gambar di bawah. 
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� Pada bahagian Output raster:, klik butang Browse , pilih lokasi dimana anda 

ingin menyimpan data tersebut dan namakannya LanduseRecc  

� Klik butang OK. 

 

Kini anda akan ulangi proses ini semula bagi data Soil. 

 

� Di dalam ArcMap, klik Spatial Analyst > Reclassify 

� Kotak dialog Reclassify akan dipaparkan. 

� Pada bahagian Input raster:, pilih Soil. 

� Pada bahagian Reclass field:, field VALUE automatik akan dipilih. 

� Pada bahagian Set values to reclassify, tukar nilai yang terdapat di dalam 

bahagian New values seperti yang terdapat di dalam Score Modelling.xls. 

� Pada bahagian Output raster:, klik butang Browse , pilih lokasi dimana anda 

ingin menyimpan data tersebut dan namakannya SoilRecc.  

� Klik butang OK. 

 

LANGKAH 7: MENGGABUNGKAN KESEMUA DATA RASTER 

 

Setelah kesemua data yang anda perlukan telah dihasilkan, kini proses yang seterusnya 

adalah menggabungkan kesemua data tersebut dengan menggunakan Spatial Analyst 

bagi mencari kawasan yang paling berisiko berlakunya hakisan tanah.Proses 

menggabungkan kesemua data-data ini boleh dilakukan dengan menggunakan Raster 

Calculator ataupun ModelBuilder,tetapi di dalam latihan anda hanya akan 

menggabungkannya dengan menggunakan ModelBuilder. 

 

� Di dalam ArcMap, klik ikon ArcToolbox  bagi melancarkannya. 

� Di dalam kotak dialog ArcToolbox, klik butang kanan tetikus pada ArcToolbox > 

New Toolbox seperti gambar di bawah. 
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� Dan namakan toolbox baru sebagai Hakisan. 

� Klik butang kanan tetikus pada toolbox baru (Hakisan) > New > Model seperti 

gambar di bawah. 
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� Tetingkap dialog Model akan dipaparkan. 

 

� Di dalam ArcToolbox, klik tanda tambah yang terdapat di sebelah Spatial Analyst 

Tools > Math kemudian klik dan seret Plus ke dalam tetingkap dialog 

Model seperti gambar di bawah.  

 

� Di dalam tetingkap Model, klik dua kali pada Plus. 

� Kotak dialog Plus akan dipaparkan. 
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� Pada bahagian Input raster or constant value 1, pilih SoilRecc,  

� Pada bahagian Input raster or constant value 2, pilih LanduseRecc. 

� Pada bahagian Output raster klik butang Browse , pilih lokasi dimana anda 

ingin menyimpan data tersebut dan namakannya SoilLanduse, seperti gambar 

di bawah. 

 

  

�  Klik butang OK pada dialog Plus. 

� Setelah selesai tetingkap Model anda akan kelihatan seperti gambar di bawah. 
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Di sebabkan Tool Plus ini hanya membolehkankan anda untuk menambah dua raster 

sahaja pada masa yang sama, kini anda perlu memasukkan Tool Plus yang kedua bagi 

melengkapkan Model ini. 

� Di dalam ArcToolbox, klik Tool Plus dan seret ke dalam tetingkap Model. 

� Klik butang Add Connection  dan bina hubungan diantara SoilLanduse dan 

Tool Plus yang kedua seperti gambar di bawah dengan cara klik pada 

SoilLanduse dan tarik ke Tool Plus (2). 

 

� Klik dua kali pada Tool Plus (2). 
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� Kotak dialog Plus (2) akan dipaparkan. 

� Pada bahagian Input raster or constant value 2, pilih SlopeRecc. 

� Pada bahagian Output raster klik butang Browse , pilih lokasi dimana anda 

ingin menyimpan data tersebut dan namakannya Hakisan, seperti gambar di 

bawah. 

 

� Klik butang OK. 

 

Setelah selesai tetingkap Model anda akan kelihatan seperti gambar di bawah. 
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� Klik pada butang Run   bagi melancarkan Model yang telah anda bina ini. 

� Dialog yang menunjukkan proses yang sedang dijalankan akan dipaparkan. 

 

� Klik butang Close setelah selesai. 

� Di dalam ArcMap, setelah selesai kini anda boleh tutup model anda. 

� Bagi melihat keputusan yang dihasilkan, klik butang Add Data . 

� Pergi ke lokasi dimana anda simpan output bagi model anda tadi, klik Hakisan 

dan klik butang Add. 

 

Anda bolehlah menukar simbol  atau mengurangkan pecahan kelasnya bagi data 

Hakisan tersebut, agar lebih mudah untuk anda melihat dan membezakannya. Daripada 

keputusan ini jumlah markah yang tertinggi adalah kawasan-kawasan yang 

berkemungkinan besar menghadapi risiko berlakunya hakisan. 

 

LANGKAH 8: KELUAR ARCMAP 

 

� Pada menu ArcMap, klik File > Exit 

� Klik No apabila dialog dipaparkan. Anda tidak perlu menyimpan (save) kerja-

kerja yang telah anda lakukan 

 

 

 


